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Requirements for Testing With Assistive Technology 
When administering RISE tests to students who will be using Assistive Technology, there are several requirements that must 
be met before testing. 

1. Review the information in the RISE Test Administration Manual (TAM) and TIDE User Guide. 

a. While this Assistive Technology Manual covers the specific technical details of using Assistive Technology 
while testing, it is not the only manual you will need for testing. The Test Administration Manual outlines 
general requirements for all test administrators (including using the approved scripts in the TAM) and 
provides guidance on using the RISE Test Delivery System (TDS).  The TIDE User Guide explains how to use 
the Test Information Distribution Engine (TIDE). You will use both TDS and TIDE when setting 
accommodations for students and when administering their tests, so it’s imperative that both ancillaries are 
used in conjunction with the Assistive Technology Manual.  

2. The use of Assistive Technology requires state approval. In addition to providing approval, USBE can also provide 
guidance and certain hardware or software (e.g., Braille embossers) for specific test accommodations as applicable 
and available. Contact Jessica Wilhelm (Jessica.Wilhelm@schools.utah.gov) and Emily Engh 
(emily.engh@schools.utah.gov) at the Utah State Board of Education (USBE) to confirm and discuss your testing 
accommodations. 

Overview of Testing with Assistive Technology  
This manual provides an overview of the embedded and non-embedded assistive technology tools that can be used to help 
students with special accessibility needs complete online tests in the Test Delivery System (TDS). It includes lists of 
supported devices and applications for each type of assistive technology that students may need, as well as setup 
instructions for the assistive technologies that require additional configuration in order to work with TDS. 

• Embedded assistive technology tools include the built-in test tools in TDS, such as the Text-to-Speech and Speech-to-
Text tools. These tools can be accessed without third-party software or hardware and do not require Assistive 
Technology to be turned on in TDS. 

o The embedded assistive Text-to-Speech , Speech-to-Text, zoom technology, and word prediction tools in TDS 
are available on supported desktop and mobile devices.  

• Non-embedded assistive technology tools are the third-party hardware and accessibility software that students use to 
help them complete tests in TDS. These tools require Assistive Technology to be turned on in TDS and may require 
additional configuration steps prior to testing. 

o Most of the non-embedded assistive technology tools covered in this manual are supported by Windows and 
macOS desktops only. Mobile devices, such as Chromebooks and iPads, do not support Assistive Technology to 
be turned on in TDS, which is required for non-embedded technology. More detailed system requirements are 
provided for each assistive technology tool throughout this manual. 

o Turning on Assistive Technology in macOS is supported only with Secure Browser version 16.5. Ensure that the 
proper Secure Browser version is downloaded from the RISE Portal to allow for testing with Assistive 
Technology.  

Students who use assistive technologies to interact with a standard web browser should be able to use those same 
technologies with TDS, unless they are web-based applications or browser extensions. The best way to test compatibility 
with assistive technologies is to take a training test in the Secure Browser with those technologies turned on. If they do not 
work, refer to the additional configuration instructions in this manual as required. If you still have questions about the 

https://utahrise.org/resources/user-guides/user-guides/test-administration-manual
https://utahrise.org/resources/user-guides/user-guides/tide-user-guide
mailto:tracy.gooley@schools.utah.gov
mailto:emily.engh@schools.utah.gov
https://utahrise.org/secure-browsers.html
https://utahrise.org/secure-browsers.html
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assistive technology tools covered in this guide, please contact the RISE Helpdesk (by email at 
RISEhelpdesk@cambiumassessment.com or by phone at 877-269-4966). 

The guide includes the following sections: 

• Testing with Speech-to-Text Technology 

• Testing with Word Prediction Technology 

• Testing with Alternative Computer Input Technology 

• Testing with Assistive Keyboard and Mouse Input Technology 

• Testing with Screen Magnifier Technology 

• Testing with Text-to-Speech 

• Testing with Assistive Technology for Braille Tests 

Note: If testing students with screen readers using JAWS, please refer to Table 11 in this document for an overview of the 
keyboard commands students may use. 

  

mailto:RISEhelpdesk@cambiumassessment.com
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Using Assistive Technology  
Assistive Technology is a TDS accommodation that allows students to use non-embedded assistive technology to complete 
tests in the Secure Browser. It must be turned on for any students testing with third-party assistive technology tools. When 
Assistive Technology is turned on, the Secure Browser's security settings will be partially lowered to allow students to use 
tools that would otherwise be blocked. This accommodation should be assigned to students in TIDE before they begin 
testing.  

Please note that using assistive technology requires state approval so that applications can be removed from the forbidden 
applications list in the Secure Browser.  School and LEA level users can submit requests for state approval to use assistive 
technology through CAI’s TIDE system. Forms to request assistive technology or scribes are accessible via the TIDE 
Dashboard, as seen below. For detailed instructions, please refer to the RISE TIDE User Guide. 

Assistive Technology Request Forms in TIDE 

 

Assistive Technology is available only for computers running supported desktop Windows and macOS operating systems. 
Turning on Assistive Technology on macOS devices is supported only with Secure Browser version 16.5. When using 
Windows devices, the task bar remains on-screen throughout the test after enabling accessibility software. However, 
forbidden applications are still prohibited. 

Assistive Technology activates when students are approved for testing in TDS. The student's assistive technology should 
already be set up for use with TDS when they begin testing with Assistive Technology, which is set by state personnel. 

Windows Shown with Task Bar 

 

https://utahrise.org/resources/user-guides/user-guides/tide-user-guide
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MacOS Shown with Task Bar 

 

When Assistive Technology is turned on, standard keyboard navigation in the Secure Browser will be disabled in order to 
accommodate any potential keyboard commands associated with the assistive technology the student may be using. For 
information about standard keyboard commands in the Secure Browser, see the RISE Test Administration Manual.  

How to Use Assistive Technology on Windows 
Students can follow the instructions in this section to use assistive technology alongside the Secure Browser with all 
supported Windows operating systems. 

1. Open the required accessibility software on the student’s testing device. 

2. Open the Secure Browser. Complete the sign-in process up to the proctor approval step.  See the RISE Test 
Administration Manual for detailed instructions on the sign-in process. 

3. When a student is approved for testing, the Secure Browser allows the operating system’s menu and task bar to appear. 
 Windows: On Windows, the Secure Browser resizes, and the taskbar remains visible inside the test in its usual 

position.  Students can press Alt+Tab to switch between the Secure Browser and accessibility applications that they 
are permitted to use in their test session. 

4. The student must immediately switch to the accessibility software that is already open on the computer so that it 
appears over the Secure Browser. The student cannot click within the Secure Browser until the accessibility software 
is configured. 
 Windows: Click the accessibility software application in the task bar. 

a. If the student needs to test with multiple accessibility applications simultaneously, they should configure all of them 
during this step. 

https://utahrise.org/resources/user-guides/user-guides/test-administration-manual
https://utahrise.org/resources/user-guides/user-guides/test-administration-manual
https://utahrise.org/resources/user-guides/user-guides/test-administration-manual
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5. After configuring the accessibility software settings, the student returns to the Secure Browser and continues the sign-in 
process. At this point, the student can no longer switch back to the accessibility software. If changes need to be made, 
the student must sign out and then sign in again. 

Once Assistive Technology is turned off, the Secure Browser reoccupies the whole screen, and the student’s ability to use 
assistive technologies or switch between any other applications and the Secure Browser is suppressed. 

How to Use Assistive Technology on macOS Secure Browser version 16.5 
The Secure Browser 16.5 for macOS 13.3 & 14.0 requires students to launch approved accessibility software after logging in 
to the test. 

1. Open the required accessibility software on the student’s testing device and configure the accessibility software settings 
as needed. 

2. Open the Secure Browser and follow the standard sign-in process. 

3. On the first page of the test, click Applications  in the global menu. From the App Launcher window that pops up, 
select the appropriate assistive technology software and click OK.  

4. Return to the Secure Browser and continue testing.  

a. Students should not close the assistive technology application while the Secure Browser is still open, as they may 
not be able to relaunch it. If the student accidentally closes the assistive technology application, they must sign out 
and then sign in again. 
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Testing with Speech-to-Text Technology 
Speech-to-text (STT) technology transcribes a student’s spoken words into text for item responses in 
TDS. Students with the appropriate accommodations may use STT assistive technology while taking 
tests. Rise now has an embedded Speech-to-Text tool available.  

Table 1 on the next page provides a list of third-party STT applications that can be used in TDS. In 
addition to the applications listed in this table, students will need to use a headset while testing. Any 
wired headset with a 3.5 mm or USB connection should work. Additionally, students using STT will need 
to be tested in a separate location from other students. Third-party STT applications not listed in Table 1 
are not supported for RISE online assessment; students accustomed to using third-party STT applications 
not listed in Table 1 will need to use CAI’s embedded STT tool.  

Some applications listed in Table 1 on the next page require additional configuration to prepare for use 
during online testing. Necessary configurations are described starting on page 8. Some applications send 
data to the cloud for processing by default. Where noted, this should be disabled to ensure the security 
of test data. 

After you configure an application, CAI strongly recommends testing that application on the RISE 
training test administered through the Secure Browser prior to using it for operational testing. 

Please note: This manual includes links for users to jump to various sections within the 
document; if you wish to return to the page in this manual you were on before clicking the link to 
another section, use one of the following keyboard shortcuts: Alt + Left Arrow (for Windows 
Operating System [OS] on laptops or tablets when viewing the file in Adobe Reader) or 
Command + Left Arrow (for Mac OS X on laptops or tablets when viewing the file in Adobe 
Reader). Please note that these keyboard shortcuts do not apply to Chromebooks. If the 
keyboard shortcuts do not work or apply to your device, you can also scroll back to your previous 
location. 

 

  

https://utahrise.org/training-tests.html
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Table 1. Third-Party STT Applications 

Product System Requirements Additional Details 

Dragon Naturally 
Speaking Home & 
Individual Professional—
Windows 

• Supported Versions: 
15, 16 Professional 

• Windows 10, 11; Server 2016 R2; 
2019 R2 

• Requires additional setup before use in TDS (see configuration 
instructions) 

• TDS cannot confirm appropriate configurations are in use 
during exam, so students may be able to access prohibited 
features. 

Windows Built-in Speech 
Recognition 

• Supported Versions: 
8.0 

• Windows 10, 11; Server 2016 R2 • Requires additional setup before use in TDS (see configuration 
instructions) 

• TDS cannot confirm appropriate configurations are in use 
during exam, so students may be able to access prohibited 
features. 

• Requires state approval to be removed from the forbidden 
applications list in the Secure Browser. 

WordQ+SpeakQ 
(WordQ5) 

• Supported Version: 
5.4.29 

• Windows, 10, 11; Server  2016 R2 • Requires additional setup before use in TDS (see configuration 
instructions) 

 Exam Mode must be enabled before students begin 
testing. 

• This tool also includes a text prediction feature that cannot be 
disabled. 

Read&Write—Windows 

• Supported Versions: 
12.0.77 

• Windows 10, 11; Server 2016 R2 • Exam Mode must be enabled before students begin testing 
(this mode is not available on Read&Write for Mac). 

• Also includes text prediction features that must be turned off 
prior to testing. 

• Locked Browser Mode disables the STT functionality in 
Read&Write. You should not use Locked Browser Mode when 
using Read&Write for STT. 

Co:Writer Universal 
(Windows) 

Supported Version: 1.0.0 
(now discontinued) 

• Windows 8.1, 10, 11; Server 2012 
R2, 2016 R2 

• There are currently two versions of Co:Writer: An old, 
standalone application and a new, extension application. 

• For the old, standalone app version: 

o This is the only version of Co:Writer currently supported 
with the Secure Browser. 

o This version has been discontinued by the manufacturer, 
but schools may continue to use it with the Secure Browser 
if they still have it. 

o TDS cannot confirm appropriate configurations are in use 
during an exam, so students may be able to access 
prohibited features. 

o Requires users to enter numbers from an on-screen 
keypad. 

• For the new, extension app version: 

 This version currently cannot be used with the Secure 
Browser; Co:Writer extensions are not supported. 
Students must use CAI’s embedded Word Prediction 
tool. 

https://www.nuance.com/dragon/dragon-for-pc/home-edition.html
https://www.nuance.com/dragon/dragon-for-pc/home-edition.html
https://www.nuance.com/dragon/dragon-for-pc/home-edition.html
https://www.nuance.com/dragon/dragon-for-pc/home-edition.html
https://support.microsoft.com/en-us/help/14213/windows-how-to-use-speech-recognition
https://support.microsoft.com/en-us/help/14213/windows-how-to-use-speech-recognition
http://wordqspeakq.lgfl.net/
http://wordqspeakq.lgfl.net/
https://www.texthelp.com/en-us/products/read-write/
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Configuring Speech-to-Text Applications 
Some applications listed in Table 1 require additional configuration to prepare for use during online 
testing. Necessary configurations are described below. Some applications send data to the cloud for 
processing by default. Where noted, this should be disabled to ensure the security of test data. 

After you configure an application, CAI strongly recommends testing that application on a RISE training 
test administered through the Secure Browser prior to using it for operational testing. 

Dragon Naturally Speaking Home or Professional Individual for Windows 
Necessary configurations for Dragon Naturally Speaking can be made from the Options dialog box, 
which is accessed from the Tools drop-down list on the DragonBar. 

From the Commands tab, uncheck the following 
settings:  

 Enable launching from the Start Menu 

 Enable launching from the desktop 

 Enable E-Mail and Calendar commands 

 Enable Cut shortcut commands 

 

Figure 1. Dragon Commands Tab 

 

From the Miscellaneous tab, uncheck Use Dictation 
Box for unsupported application. 

Figure 2. Dragon Miscellaneous Tab 

 

https://utahrise.org/training-tests.html
https://utahrise.org/training-tests.html
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From the Scheduled Tasks tab of the 
Administrative Settings window, do one of the 
following:  

• In Dragon 16, uncheck Help us Improve 
Dragon. 

• In Dragon 15, uncheck Enable schedule 
Data Collection 

Figure 3. Admin Settings Schedule Tasks Tab (Dragon 
16) 

 

Setting Up User Profiles for Students in Dragon 
Dragon Naturally Speaking requires each student to use a specific User Profile. You will need to create 
User Profiles and ensure that Dragon Naturally Speaking is set to the proper profile for each student 
prior to testing. When creating a profile, you can select the student’s age range, language, and accent, 
as well as set the audio input devices. Students will then read aloud prompts that Dragon Naturally 
Speaking uses to learn their voice. After creating profiles, you can select Profiles in the Dragon toolbar, 
then click Open User Profile… to switch between User Profiles (see Figure 4). For more information 
about creating User Profiles, see the Dragon Naturally Speaking—Windows website. 

 

Figure 4. Dragon Naturally Speaking—Open User Profiles 

 

  

https://www.nuance.com/dragon/dragon-for-pc/home-edition.html
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Windows Speech Recognition 
Prior to the testing,  Windows built-in Speech Recognition application must be set up on each testing 
device that will be used by students who require STT. The application can be set up through the 
Windows Control Panel. Users should set the device to not send data to Microsoft for improvement so 
that secure test data is not sent to the cloud. During setup, Speech Recognition Voice Training must be 
completed by the student for optimal performance. 

To prevent Windows from sending data to the cloud, go to Start > Settings > Privacy > 
Diagnostics & Feedback and mark the Basic radio button in the Diagnostic Data section. Then 
select the Speech tab and set the Online Speech Recognition toggle to Off. 

While Windows Speech Recognition is processing speech, the testing site may slow down. If 
transcription is not needed for testing, make sure Windows Speech Recognition is not listening 
in order to prevent this slowness from interfering with the test performance 

Read & Write (Windows) 
Read and Write has an Exam Mode that must be used to turn off features for a single student on their 
particular testing device. When exam mode is enabled, the student will have access to only the selected 
features on the toolbar and certain speech settings, including voice selection, speed, pitch and Speak As 
I Type (the full settings menu will not be accessible). Predictive text must be turned off. 

To use Exam mode, run Read and Write and click on the settings button in the upper-right corner and 
then click Show more settings. in the Find a Setting field, type adminsettings. You will be asked to enter 
and confirm a password to grant access on this computer. When logged into administrator settings, click 
the Select your features tab and select which features you’d like to be enabled on the student’s toolbar. 
Enable the Use Exam Mode now toggle to start Exam Mode, then close the Read and Write menu to 
start the exam. 

 



  

© Cambium Assessment, Inc.    11 

 

Testing with Word Prediction Technology 
Word prediction assistive technology suggests words to students as they type responses for test items. 
Rise has an embedded word prediction tool available and supported on desktops and mobile devices. If 
a third-party Word Prediction tool still needs to be used, please reference the table below. The table 
also provides the technology requirements for students testing with word prediction assistive 
technology.  

Table 2. Third-Party Word Prediction Applications 

Product System Requirements Additional Details 

WordQ+SpeakQ (WordQ5) 
• Supported 

Version: 5.3.5 

• Windows 10, 11; Server 
2016 R2 

• macOS 13.3 

• Requires additional setup before use in TDS (see 
configuration information)  

• Exam Mode must be enabled before students begin 
testing. 

Read&Write for Windows 
& macOS 

• Supported 
macOS Versions: 
7.1.3, 7.1.5, 7.1.6 

• Supported 
Windows 
Version: 12.0.73, 
12.0.7 

• R&W 7.1.6 is compatible 
with macOS 13.3, 14 

• R&W 12.0.75 is compatible 
with Windows 11 

• R&W 12.0.73 is compatible 
with Windows 8.1, 10; 
Server 2012 R2, 2016 R2 

• TDS cannot confirm appropriate configurations are in use 
during an exam, so students may be able to access 
prohibited features.  

• Requires additional setup before use in TDS (see 
configuration information)  

• The Windows version also includes speech-to-text 
functionality that students may use if they have the 
proper accommodations. 

• To use text prediction feature in Windows, students can 
press the available function keys from F1 to F8. 

• Includes a Screen Recording feature that should be 
disabled for Read and Write via System Settings > 
Privacy & Security > Screen Recording. 

Co:Writer Universal 
(Windows) 

• Supported 
Version: 1.0.0 
(now 
discontinued) 

• Windows 8.1, 10, 11; Server 
2012 R2, 2016 R2 

• There are currently two versions of Co:Writer: An old, 
standalone application and a new, extension application. 

• For the old, standalone app version: 

o This is the only version of Co:Writer currently supported 
with the Secure Browser. 

o This version has been discontinued by the manufacturer, 
but schools may continue to use it with the Secure Browser 
if they still have it. 

o TDS cannot confirm appropriate configurations are in use 
during an exam, so students may be able to access 
prohibited features. 

o Requires users to enter numbers from an on-screen 
keypad. 

• For the new, extension app version: 

o This version currently cannot be used with the Secure 
Browser; Co:Writer extensions are not supported. Students 
must use CAI’s embedded Word Prediction tool.  

https://utahrise.org/secure-browsers.html
http://wordqspeakq.lgfl.net/
https://www.texthelp.com/en-us/products/read-write/
https://www.texthelp.com/en-us/products/read-write/
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WordQ5 
To minimize security risks, WordQ includes an Exam Mode feature, which can be enabled through the 
application’s settings. Exam Mode requires a time limit of 1–12 hours to be set. Please note, this does 
not eliminate all security risks, and once Exam Mode has been set, it cannot be disabled until the 
configured time has run out. 

To turn on exam mode, click the Options icon, and select Exam Mode. In the dialog popup window that 
appears, you can allow and restrict the Word usage examples and Single words added by the user 
including topic words features. You can also set the exam time limit at the bottom of the window. 

Read&Write (Windows Only) 
Read&Write has an Exam Mode that can be used to turn off features for a single student on their 
particular testing device. This feature is not currently available for macOS. When Exam Mode is enabled, 
the student will have access to only the selected features on the toolbar. For students requiring word 
prediction, Word Prediction should be enabled. Read&Write for Windows also includes text-to-speech 
and speech-to-text (talk & type) features, which should be enabled for students with the proper 
accommodation settings only.  

To use Exam mode, run Read & Write and click the settings button in the top-right corner, then click 
Show more settings. In the Find a Setting field, type adminsettings. Enter and confirm a password to 
grant access on this computer. This username and password are associated with the administrative 
account for your Read&Write subscription. When logged in to administrator settings, click the Select 
your features tab and select which features you’d like to be enabled on the student’s toolbar. Enable 
the Use Exam Mode now toggle to start Exam Mode, then close the Read&Write menu to start the 
exam.
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Testing with Alternative Computer Input Technology 
Alternative Computer Input (ACI) assistive tools allow students with various impairments (such as 
physical and visual impairments) to interact with a computer without using a traditional mouse and 
keyboard setup. For instance, ACI technology such as PCEye Mini tracks students' eye movement, while 
Dwell Clicker 2 allows students to use a mouse without having to click the left or right mouse buttons. 

TDS does not include any embedded alternative computer input tools, but it supports several third-party 
alternative computer input technologies.   

Table 3 provides a list of third-party ACI devices that can be used in TDS. Please note that this list 
includes only the devices that CAI has thoroughly tested against the Secure Browser, but there may be 
additional supported ACI devices that have not been tested yet. If your students need to use an ACI 
device not listed here, please test it out in a training test first to ensure there are no issues with it. 

Please note: If you wish to return to the page in this manual you were on before clicking the link 
to another section, use one of the following keyboard shortcuts: Alt + Left Arrow (for Windows 
Operating System [OS] on laptops or tablets when viewing the file in Adobe Reader) or 
Command + Left Arrow (for Mac OS X on laptops or tablets when viewing the file in Adobe 
Reader). Please note that these keyboard shortcuts do not apply to Chromebooks. If the 
keyboard shortcuts do not work or apply to your device, you can also scroll back to your previous 
location. 

Table 3. Third-Party ACI Devices 

Product System Requirements Additional Details 

PCEye Mini with Windows 
Control 

• Windows   10 • Requires additional setup before use in 
TDS (see configuration instructions) 

Dwell Clicker 2 

• Supported Versions: 
2.0.1.8 

• Windows 10, 11; Server 2016 R2 • Requires additional setup before use in 
TDS (see configuration instructions) 

HeadMouse Nano • Windows  10, 11; Server  2016 R2 

• macOS 13.3, 14 

• Requires additional setup before use in 
TDS (see configuration instructions) 

Access Switch • Windows  10, 11; Server 2016 R2 

• macOS 13.3, 14 

• N/A 

Swifty  

• Supported Versions: 
SW2 

• Windows  10, 11; Server  2016 R2 

• macOS 13.3, 14 

• Requires additional setup before use in 
TDS (see configuration instructions) 

 

  

https://www.tobiidynavox.com/pages/pceye
https://www.tobiidynavox.com/pages/pceye
https://thinksmartbox.com/product/dwell-clicker/
http://www.orin.com/access/headmouse/
https://www.ablenetinc.com/technology/switches/specs-switch#Specifications
http://www.orin.com/access/swifty/
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Configuring PCEye Mini with Windows Control on Student Devices 
To configure the PCEye Mini, it should be plugged in to a computer that uses Windows Control software 
and should be installed by following the product’s installation instructions manually.  

For students using PCEye Mini with Windows Control Software, the Word Prediction feature should be 
disabled by opening the application and navigating to Settings>Keyboard. 

Configuring Dwell Clicker 2 
To configure Dwell Clicker 2 settings, open the application and select the keyboard icon, then click the 
Options key. In the window that pops up, make sure the Use Text Prediction checkbox is not checked. 

Configuring HeadMouse Nano 
To configure HeadMouse Nano when using the SofType keyboard, open the SofType application and 
select View>Word Bar from the menu. Then make sure the Prediction radio button is not marked. 

Configuring HeadMouse Nano for macOS 
The HeadMouse Nano on OSX can be used to mimic mouse clicking movements only in conjunction with 
an Access Switch device (such as an AbleNet Switch) and the regular Apple on-screen keyboard. When 
completing a test with a Switch, students can left click, drag and drop, double click and right click (right-
clicking would require an additional Switch).  

To configure HeadMouse Nano when using the Apple on-screen keyboard, open System Preferences > 
Keyboard > Text. Then make sure the following checkboxes are not marked:  

Add period with double-space 

Capitalize words automatically 

Correct spelling automatically 

Configuring Swifty: SW2 
To configure Swifty Switch Access according to the student’s needs, the following DIP Switches should 
be set when using Switch. After you modify DIP Switch settings, unplug and re-plug Swifty to activate the 
settings. 

Switch 1 Switch 2 USB Device Interface Actions 

ON ON Mouse Left, Right, Middle 
OFF ON Joystick Btn1, Btn2, Btn3 
ON OFF Keyboard (For iPad) Enter, Space, Tab 
ON OFF Keyboard 1,2,3 
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Testing with Assistive Keyboard and Mouse Input 
Technology 
Assistive Keyboard and Mouse Input tools provide additional support to students with physical 
impairments who need to use a keyboard and mouse in order to respond to test items. These include 
keyboards with larger keys, computer mice with trackballs, and other tools that make it easier for 
students with limited movement abilities to use a computer. 

TDS does not include any embedded assistive keyboard and mouse input tools, as these tools typically 
involve the use of special hardware, but TDS does support several third-party assistive keyboard and 
mouse input tools.   

Table 4 provides a list of third-party assistive keyboard and mouse input tools that can be used in TDS. 
Please note, there may be additional supported assistive keyboards and mouse input tools that have not 
been tested yet. If your students need to use a device not listed here, please test it out in a training test 
first to ensure there are no issues with it. 

Some third-party assistive keyboards have special function keys that put the computer to sleep. If 
pressed, the computer will go to sleep and the student will be kicked out of the test and will have to sign 
back in to resume testing. 

Please note: If you wish to return to the page in this manual you were on before clicking the link 
to another section, use one of the following keyboard shortcuts: Alt + Left Arrow (for Windows 
Operating System [OS] on laptops or tablets when viewing the file in Adobe Reader) or 
Command + Left Arrow (for Mac OS X on laptops or tablets when viewing the file in Adobe 
Reader). Please note that these keyboard shortcuts do not apply to Chromebooks. If the 
keyboard shortcuts do not work or apply to your device, you can also scroll back to your previous 
location. 

Table 4. Third-Party Assistive Keyboard and Mouse Input Technology 

Product System Requirements Additional Details 

Keys-U-See Keyboard • Windows 10, 11; Server 2016 R2 • N/A 

BigKeys Keyboard 

• Supported Versions: 
Plus, XL 

• Windows 10, 11; Server  2016 R2 

• macOS 13.3, 14 

• N/A 

BigTrack2 Trackball • Windows 10, 11; Server 2016 R2 

• macOS 13.3, 14 

• N/A 

https://www.ablenetinc.com/search.php?search_query=Keys-U-See&section=product
http://www.bigkeys.com/
https://www.ablenetinc.com/bigtrack-2
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Testing with Screen Magnifier Technology 
Screen magnifier assistive technology enlarges the content displayed on the computer screen in order to 
assist students with visual impairments. Although TDS supports some non-embedded screen magnifier 
tools from third parties, CAI strongly recommends students use the embedded zoom tools in TDS. These 
embedded tools were designed to magnify test content in the most intuitive and user-friendly manner 
for students.  

The embedded zoom tools in the Secure Browser allow students to magnify test content to the 
following levels (any zoom levels of 5X and greater require the streamlined mode test setting in TDS to 
be turned on, which will arrange test content vertically)*: 

• 1X (12 pt. font – no zoom applied) 

• 1.5X (24 pt. font) 

• 1.75X (31 pt. font) 

• 2.5X (41 pt. font) 

• 3X (51 pt. font) 

• 5X (85 pt. font) 

• 10X (172 pt. font) 

• 15X (229 pt. font) 

• 20X (340 pt. font) 

*NOTE: Certain Chromebooks may have difficulty rendering the highest levels of zoom onscreen. It is recommended that those needing high 
levels of magnification be placed on an alternative supported operating system with a large screen. 

The font sizes listed above are approximate. After setting the print size zoom level, CAI strongly 
recommends testing that application on a RISE training test administered through the Secure Browser 
prior to using it for operational testing. 

Table 5 on the next page provides a list of third-party screen magnifier tools that can be used in TDS. 
The non-embedded screen magnifier tools listed below come with an increased risk of interoperability 
issues, require students to manually pan the magnification tool across the screen, and can include 
unwanted features that should not be used while testing. These non-embedded tools also cannot be 
tracked by RISE when gathering data about students’ tool use. 

  

https://utahrise.org/training-tests.html
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Please note: If you wish to return to the page in this manual you were on before clicking the link 
to another section, use one of the following keyboard shortcuts: Alt + Left Arrow (for Windows 
Operating System [OS] on laptops or tablets when viewing the file in Adobe Reader) or 
Command + Left Arrow (for Mac OS X on laptops or tablets when viewing the file in Adobe 
Reader). Please note that these keyboard shortcuts do not apply to Chromebooks. If the 
keyboard shortcuts do not work or apply to your device, you can also scroll back to your previous 
location. 

Table 5. Third-Party Screen Magnifier Applications 

Product System Requirements Additional Details 

ZoomText Magnifier (with 
optional text-to-speech) 

• Supported Versions: 2021, 
2022, 2023 

• Windows  10, 11; 2016 R2 

 

• ZoomText includes a SpeakIt text-to-speech 
tool that could be used to read aloud 
passages, which is not permitted on ELA tests. 
Students testing with ZoomText should use 
the magnification features only. It is 
recommended that students requiring text-to-
speech support use the Secure Browser’s 
embedded TTS tools, and that students 
requiring screen readers use JAWS or Fusion. 

Fusion Professional (combines 
JAWS screen reader with zoom 
text) 

• Supported Versions: 2021, 
2022, 2023 

• Windows  10, 11; 2012 R2, 
2016 R2 

• Minimum Requirements: 
2.0 GHz i7 dual core 
processor, 16 GB RAM 

• Requires additional setup before use with TDS 
(see configuration instructions for JAWS). 

 

https://www.zoomtext.com/products/zoomtext-magnifierreader/
https://www.zoomtext.com/products/zoomtext-magnifierreader/
http://www.freedomscientific.com/products/software/fusion/
http://www.freedomscientific.com/products/software/fusion/
http://www.freedomscientific.com/products/software/fusion/


  

© Cambium Assessment, Inc.    18 

 

Testing with Text-to-Speech 
Text-to-Speech (TTS) tools read aloud text that appears on the screen for all students. TDS includes 
embedded TTS tools that are automatically turned on for students taking RISE assessments (except for 
reading passages and excerpts). In order for students to test with TTS tools, a supported voice pack will 
need to be installed on their device before testing begins, if the device does not already include a built-
in voice pack. Students testing with TTS must have headphones. 

For more information about enabling English and Spanish voice packs, see the Windows, macOS, and 
Chrome support pages on this topic. 

TTS is available on all operating systems supported by TDS (for a full list of supported operating systems, 
see the Quick Guide for Setting up Your Online Testing Technology). However, text-to-speech tracking 
does not function correctly on Linux OS. If students require the use of this accommodation (TTS with 
tracking), they must use a different operating system. 

Table 6 lists the voice packs supported for students testing with TTS. Students can verify that text-to-
speech works on their computers by logging in to a training test session and selecting a test for which 
text-to-speech is available. Students using TTS for the practice tests must log in using a supported 
Secure Browser or a supported Chrome, Firefox, or Edge browser.   

Table 6. Technology Requirements for Students Testing with TTS  

Technology Type Product 

Supported Voice Packs • Windows for tests in English: All built-in voice packs 

• Windows for tests in Spanish: Spanish (Mexcio) 

• macOS built-in voice packs 

• iPadOS built-in voice packs 

• Chromebook built-in voice packs 

• Heather Infovox iVox HQ (macOS only) 

• Rosa Infovox iVox HQ (macOS only) 
 

 

Note: CAI strongly encourages schools to test the text-to-speech settings before students take 
operational tests. You can check these settings through the diagnostic page. From the student training 
test login screen, click the Run Diagnostics link, and then click the Text-to-Speech Check button. 

The best voice packs to use for text-to-speech in the RISE test system are the default ones provided on 
one’s device/operating system; however, the RISE system supports additional voice packs if they’ve 
been installed on devices through a third party as long as CAI has them on their allow list. If you’ve 
installed an additional voice pack on devices in your LEA through a third party, make sure the license is 
up-to-date. If you do not see your additional voice pack listed as an available voice for your RISE test in 
the TTS Sound Check page, contact CAI via the Help Desk RISEhelpdesk@cambiumassessment.com so 
they can make sure it’s on the allow list.  CAI and USBE also highly recommends having students use the 
training tests to check their devices if there are any questions about what the voice packs sound like so 
they select one they prefer. 

https://support.microsoft.com/en-us/topic/download-languages-and-voices-for-immersive-reader-read-mode-and-read-aloud-4c83a8d8-7486-42f7-8e46-2b0fdf753130
https://support.apple.com/guide/mac-help/change-the-voice-your-mac-uses-to-speak-text-mchlp2290/12.0/mac/12.0
https://support.google.com/chromebook/answer/11221616?hl=en
https://utahrise.org/resources/technology-resources/quick-guide-for-setting-up-your-online-testing-technology
mailto:RISEhelpdesk@cambiumassessment.com
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How the Secure Browser Selects Voice Packs 
This section describes how CAI’s Secure Browsers select which voice pack to use. 

Voice Pack Selection on Mobile Versions of Secure Browsers 
The Mobile Secure Browser uses either the device’s native voice pack or a voice pack embedded in the 
Secure Browser. Additional voice packs downloaded to a mobile device are not recognized by the 
Mobile Secure Browser.  

Text-to-Speech and Mobile Devices 
Text-to-speech (TTS) in Windows, Mac, and iPads includes a feature that allows students to pause and 
then resume TTS in the middle of a passage. On Chromebooks, however, students should highlight the 
desired text to be read as the pause feature does not allow students to pause and resume the reading 
again. 
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Testing with Assistive Technology for Braille Tests 
Braille tests administered in TDS require the use of multiple assistive technology devices and 
applications, which could include Refreshable Braille Display (RBDs),  JAWS screen readers used by 
students to read and navigate test content and the embossers used by Test Administrators to print test 
content. On some items, students may need to use tactile manipulatives in order to access the item’s 
content. The tactile manipulatives should be what is used instructionally and this will NOT invalidate the 
assessment score. 

RBDs are used to read text-only content on ELA tests, while Braille embossers are needed to read any 
content with images in ELA tests, as well as advanced content in Mathematics and Science tests. RBDs 
must be properly setup before they can be used by students. For information about installing and 
setting up RBDs, refer to the product’s provided instructions and manuals. 

TDS includes several embedded tools that facilitate Braille testing, such as Braille presentation settings, 
various print tools for embossing content, and streamlined mode, which arranges test content vertically. 
The specific Braille code a student needs for testing must be set in TIDE prior to administering the 
Interim or Summative assessments.  For the RISE Benchmark Modules, this will be set in the TA Interface 
prior to testing. 

Note: Alt text for the images in items and stimuli is consistently available only when the test Language is 
set to braille in TIDE prior to administering the assessment. 

Table 7 on the next page provides a list of supported screen reader software that students can use in 
TDS. Please note that only JAWS may be used on ELA and Reading tests, as this is the only supported 
screen reader that can effectively mute reading passages. Screen readers other than JAWS must not be 
used on ELA and Reading tests, as they would allow students to listen to passages instead of reading 
them, compromising the ability to assess their reading comprehension skills and therefore 
compromising the validity of the Reading assessment score. 

Please notify USBE if students will be using braille and/or screen readers; contact Jessica Wilhelm 
(Jessica.Wilhelm@schools.utah.gov) and Emily Engh (emily.engh@schools.utah.gov).  

 

  

mailto:tracy.gooley@schools.utah.gov
mailto:emily.engh@schools.utah.gov
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Please note: If you wish to return to the page in this manual you were on before clicking the link 
to another section, use one of the following keyboard shortcuts: Alt + Left Arrow (for Windows 
Operating System [OS] on laptops or tablets when viewing the file in Adobe Reader) or 
Command + Left Arrow (for Mac OS X on laptops or tablets when viewing the file in Adobe 
Reader). Please note that these keyboard shortcuts do not apply to Chromebooks. If the 
keyboard shortcuts do not work or apply to your device, you can also scroll back to your previous 
location. 

Table 7. Screen Readers Supported for Student Computers 

Screen Reader System Requirements Additional Details 

JAWS–Professional 

• Supported Versions: 
2021, 2022, 2023 

• Operating Systems: Windows 10, 
11 

 Minimum Requirements: 2.0 
GHz i5 dual core Processor, 8 
GB RAM 

• Requires additional setup before use 
with TDS (see configuration instructions) 

• Test Presentation setting must be set to 
Braille, whether or not student is a Braille 
user. 

Fusion Professional  

• Supported Versions: 
2021, 2022, 2023 

• Operating Systems: Windows  10, 
11 

 Minimum Requirements: 2.0 
GHz i7 dual core processor, 16 
GB RAM  

• Requires additional setup before use 
with TDS (see configuration instructions 
for JAWS) 

• Test Presentation setting must be set to 
Braille, whether or not student is a Braille 
user. 

NVDA 
• Supported Versions: 

2021-2023 

• Windows 10, 11 and all server 
operating systems starting from 
Windows Server 2016 R2.  

  

• Students cannot use NVDA for ELA tests, 
as the read-aloud of passages cannot be 
suppressed in this product. 

• If using an older version, use the training 
test to ensure functionality. 

Table 8 on the next page provides a list of supported refreshable Braille displays (RBDs) that students 
can use to read Braille content. Please note that if students wish to use RBDs not mentioned in this 
table, they should test them on a training test to ensure there are no issues before using them on an 
operational test. Additionally, RBDs not listed here may include unwanted features that students should 
not use while testing, so students may need to be monitored if they use such RBDs. 

  

https://www.freedomscientific.com/products/software/jaws/
https://www.freedomscientific.com/products/software/jaws/
https://www.freedomscientific.com/products/software/fusion/
https://www.nvaccess.org/download/
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Table 8. Refreshable Braille Displays Supported for Student Computers 

RBD System Requirements Additional Details 

• Brailliant 40 Cell 

 

• Windows  10, 11 • CAI recommends RBDs with at least 40 cells, but students 
may use displays with fewer cells if preferred. 

• Students should not use the HumanWare Brailliant BI 14 
RBD. It can automatically synchronize notes typed 
internally with a mail application, potentially violating 
test security.   

QBraille XL • Windows 10, 11 • Students using the QBraille XL in TDS must be monitored 
to ensure they are not accessing unwanted internal 
applications, such as the calculator and notepad. 

Active Braille • Windows 10, 11 • Device is equipped with an SD card that should be taken 
out before student takes a test. 

• Device has Notepad, Scheduler, Alarm, Calculator, and 
Clock features that cannot be disabled. Students must be 
monitored to ensure they are not using them. 

Braille Edge 40 

(now discontinued) 

• Windows 10 • Device is equipped with an SD card that should be taken 
out before student takes a test 

• Device has Notepad, Scheduler, Alarm, Calculator, 
Stopwatch, Countdown Timer, and Clock features that 
cannot be disabled. Students must be monitored to 
ensure they are not using them. 

• This product is no longer sold by HIMS. However, 
students may continue to test with it if it is already 
available for their use. 

Focus 40 Blue 5th Generation • Windows 10, 11 • Device is equipped with an SD card that should be taken 
out before student takes a test. 

• Device has Scratchpad with BRF Bookreader, Calendar, 
and Clock features that cannot be disabled. Students 
must be monitored to ensure they are not using them. 

BrailleNote Touch 32 Cell • Windows  10, 11 • Students using this product in TDS must be monitored to 
ensure they are not accessing prohibited features. 
Student can only use this device in Braille Terminal mode. 
Students cannot take tests on the tablet of this device. 

• Device equipped with SD card which should be taken out 
before student takes a test 

• Other applications present include a Word processor, 
Email, Internet, Contacts, Planner, File Manager, 
Calculator, Victor-Reader, Play Store, and KNFB Reader. 

 

  

https://store.humanware.com/hus/brailliant-bi-40-new-generation.html
https://www.hims-inc.com/product/qbraille-xl/
http://northstateat.com/Active-Braille_p_263.html
https://www.freedomscientific.com/products/blindness/focus40brailledisplay/
https://store.humanware.com/hus/blindness-braillenote-touch-plus-32.html
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Table 9 provides a list of embossers and embossing software supported for TA computers. Embossers 
must be used to print any test content that cannot be read by RBDs, this includes all content on 
Mathematics and Science tests, and some of the content on ELA tests.  

USBE provides embossers and Tiger Designer Suite software for braille test administrations; please 
contact Emily Engh (emily.engh@schools.utah.gov) for more information. 

Table 9. Embossers and Embossing Software Supported for TA Computers 

Embosser / Embossing 
Software 

System Requirements Additional Details 

Duxbury Braille Translator  

• Supported Versions: 12.1, 
12.2, 12.3, 12.4, 12.5, 
12.6, or 12.7. 

 

• Operating Systems: 
Windows 10, 11 

• Minimum 
Requirements: 1 GHz 
Processor, 1 GB RAM 
(for 32-bit), 2 GB 
RAM (for 64-bit) 

• Requires additional setup before use with TDS (see 
configuration instructions) 

• Used for embossing BRF files (from print requests 
containing only text or formatted tables) 

Tiger Software Suite (Tiger 
Designer) 

• Supported Versions: 6, 
7, 8 

• Windows 10, 11 • You should download Tiger Designer prior to testing, as 
some PRN files will need to be converted in this program 
before embossing.  

• Please see PRN conversion instructions for more details. 

• Tiger Software Suite is included with all ViewPlus embossers 
and its license can be used on up to two devices. 

ViewPlus Max Embosser, 
ViewPlus Premier Embosser, 
or ViewPlus Rogue Embosser  

Viewplus Columbia 
Embosser, ViewPlus 
Columbia 2 Embosser,  
PixBlaster 

• Windows  10, 11 • Requires additional setup before use with TDS (see 
configuration instructions) 

• Used for embossing PRN files (from print requests with 
tactile or spatial components, such as images) 

• PRN files are formatted for a specific printer driver (e.g., 
Max embosser). Thus, you may need to convert the PRN file 
in Tiger Designer for use with another supported embosser 
(see PRN conversion instructions 

ViewPlus Desktop Embosser 
(driver for ViewPlus Embossers 
and Tiger Viewer Software) 

• Windows  10, 11 • You should download Tiger Designer prior to testing, as 
some PRN files will need to be converted in this program 
before embossing.  

• Please see PRN conversion instructions for more details. 

• Tiger Software Suite is included with all ViewPlus embossers 
and its license can be used on up to two devices.  

• Download and install your embosser driver prior to 
embossing any files.  

• The Tiger Viewer software is downloaded in the printer 
driver folder. 

mailto:emily.engh@schools.utah.gov
http://www.duxburysystems.com/dbt_main.asp
https://viewplus.com/product/tiger-software-suite/
https://viewplus.com/product/vp-columbia-2/
https://viewplus.com/product/vp-columbia-2/
https://viewplus.com/product/vp-columbia-2/
https://viewplus.com/product/vp-columbia-2/
https://viewplus.com/product/vp-columbia-2/
https://viewplus.com/viewplus-support/desktop-driver/
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Specifications for TAs Using Screen Readers 
If a TA requires the use of a screen reader (JAWS, NVDA) to set up or administer test sessions in the TA 
Site, CAI recommends they do so using the most recent Firefox or Chrome browser. If issues occur while 
updating browsers, please contact your network administrator/IT office. 

Configuring JAWS Screen Readers on Student Computers Before Testing 
Begins 
This section includes instructions for the additional JAWS configuration steps that Technology 
Coordinators must follow before students use JAWS for online testing. Optional voice adjustments in 
JAWS can also be made from the Options>Voices>Voice Adjustment window in JAWS. To ensure JAWS 
is properly configured, students should take training tests using JAWS before taking operational tests. 

Braille tests administered in TDS require the use of multiple assistive technology devices and 
applications, which could include Refreshable Braille Display (RBDs),  JAWS screen readers used by 
students to read and navigate test content and the embossers used by Test Administrators to print test 
content. On some items, students may need to use tactile manipulatives in order to access the item’s 
content. The tactile manipulatives should be what is used instructionally and this will NOT invalidate the 
assessment score. 

The configuration instructions in this section apply to JAWS 2021, JAWS 2022, and JAWS 2023 as well as 
Fusion Professional. 

Configuring JAWS to Recognize the Secure Browser 
You must edit the JAWS configuration file so that the software recognizes the secure browser. The 
examples below are for JAWS 2021 installed to the default location. If your version is installed to a 
different location, navigate to the appropriate directory. 

1. To modify the configuration file, open the JAWS ConfigNames.ini file. This file may appear in two 
folders. Depending on how JAWS is installed on your computer, you may need to modify both files: 

 Required: Start > All Programs > JAWS 2021 > Explore JAWS > Explore Shared Settings  

 Optional: Start > All Programs > JAWS 2021 > Explore JAWS > Explore My Settings  

2. In the ConfigNames.ini file, locate the line of text containing firefox:3=firefox. At the end of this 
line, press Enter and type UTSecureBrowser16.0=firefox 

3. At the bottom of the ConfigNames file, do one of the following: 

a. For JAWS 2023: No additional action is needed 

b. For JAWS 2022: Update the URL in the regex: line below the ;CAI testing: line so that it reads as 
regex:https:\/\/.*\.cambiumtds(uat)?\.com\/student.*=CAI Testing 
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c. For JAWS 2021: After the last line of the file, press Enter and type ;CAI testing: and then press 
Enter again and type regex:https:\/\/.*\.cambiumtds(uat)?\.com\/student.*=CAI Testing 

The end of the ConfigNames file should match the highlighted section in Figure 5. 

Figure 5. JAWS ConfigNames File – regex line 

 

4. Save the file.  

a. If you receive an error that you don't have permission to save the .ini file to this location, save 
the file to your desktop as ConfigNames.ini. Then copy the updated .ini file to the folder 
containing the original .ini file referenced in step 1. 

Optional: To confirm that JAWS has been properly configured, you can open the Secure Browser while 
JAWS is running. Then press hold down Insert (or the JAWS key) while pressing Q twice. A message 
opens in a pop-up window, indicating that Secure Browser settings are being used in the application, 
and that the configuration name is CAI Testing. 

Registering AccessibleHandler.dll 
To ensure that JAWS works properly with the Secure Browser, you should register AccessibleHandler.dll 
on the student’s testing device. These steps should be performed for all supported versions of JAWS. 

1. From the Start menu, search for File Explorer, then select Enter on the keyboard. After the File 
Explorer or Home window populates, navigate to the left-hand panel, then select Local Disk (C:) or 
Windows (C:) under This PC. 

2. Open the Program Files folder, then locate the downloaded Secure Browser folder: 
UTSecureBrowser16.0 

3. Find the Windows Batch File Type with the name RegisterAccessibilityLibs. 

4. Right click on the RegisterAccessibilityLibs.bat file and select Run as Administrator. If you are 
prompted to choose between Yes and No in a pop-up box, choose Yes. 

5. A command prompt window appears briefly with a message confirming successful registration. 

6. A message appears indicating that the action was successful. Press OK on this prompt and the 
command window automatically closes.  
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Applying Settings for Contracted Braille 
In order for students to use contracted literary Braille with their RBD, the correct JAWS settings must be 
applied prior to launching the secure browser. 

1. To apply the correct JAWS settings, open JAWS and go to Utilities > Settings Center.  The Settings 
Center window opens. 

2. From the Application drop-down list at the top of the window, select firefox. 

3. Expand the Braille settings, General sub-settings, and Translation sub-settings in the Search for 
settings panel on the left. The Settings Center window displays the options for Braille Translation 
(see Figure 6). 

a. In the Translation section, verify the Language drop-down list is set to English – United States. 
Select Unified English Braille Grade 2 from the Output and Input drop-down lists.  

i. For tests presented in the EBAE Braille type, select US English Grade 2 from 
the Output and Input drop-down lists.  

Figure 6. JAWS Settings Center Window 

 

4. In the Braille Mode section (see Figure 7), ensure that only the following settings are checked: 

 Active cursor follows Braille display 

 Braille display follows Active cursor 

 Enable Word Wrap 

 Auto Detect Braille Display using Bluetooth (if available) 
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Figure 7. Braille Mode Section  

 

5. Click Apply, and then click OK. 

Configuring JAWS to Speak “Dollars” 
You should configure JAWS to correctly speak the dollar symbol ($), in case it appears in the test 
content. 

1. Open JAWS and go to Utilities > Settings Center. The Settings Center window opens. 

2. In the Search for settings panel on the left, expand the Text Processing settings and Number And 
Date Processing sub-settings. Click Speak Dollars. The Settings Center window displays the Number 
And Date Processing options (see Figure 8). 

Figure 8. Number and Date Processing  

 

3. Mark the Speak Dollars checkbox. 

4. Click Apply, and then click OK. 
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Optional JAWS Voice Adjustment Settings 
Prior to launching the secure browser, you can adjust JAWS voice settings for students based on their 
individual needs. You must set the Voice Profile, Speaking Rate, and Punctuation settings prior to 
administering assessments. Students should take training tests using JAWS so they can determine 
whether these settings need to be adjusted. 

1. To adjust JAWS voice settings, open JAWS and go to Options > Voices > Voice Adjustment. The 
Voice Adjustment window opens (see Figure 9). 

2. To adjust the voice profile, in the Profile 
section, select a voice profile from the 
Profile Name drop-down list. Click Apply. 

3. To adjust the voice rate, in the Voice 
section, drag the Rate slider to the desired 
rate speed (the lower the rate, the slower 
the words are read aloud). Click Apply. 

4. To adjust the punctuation, click the 
Punctuation drop-down list. Select from 
the following options: None, Some, Most, 
or All. Click Apply. 

5. When all settings are saved, click OK. 

Figure 9. JAWS Voice Adjustment 

 

Configuring Embossing Software on TA Computers Before Testing Begins 
TDS allows students to emboss test material with TA approval. The software that sends print requests to 
the Braille embosser must be installed on computers that TAs use for test sessions. 

The embossed output for student print requests depends on the file type associated with a test 
question. TAs must ensure that students have the Braille Type test setting prior to approving the student 
for testing, as this determines which file type is used for printing. There are two types of files: 

• Braille Ready Format (BRF): BRF file types are used for print requests containing only text (including 
formatted tables). The Tiger Software Suite or Duxbury Braille Translator software handles BRF files. 

• Printer Output File (PRN): PRN file types are used for print requests containing tactile or spatial 
components (such as images). The ViewPlus Tiger Software Suite software handles PRN files. 

Upon approving a print request, the TA sends the file to the embosser using either Duxbury or ViewPlus 
Tiger Software Suite software. Instructions for embossing files are located in the section Embossing 
Braille Print Requests. 
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Configuring BRF Files with Duxbury Braille Translator 
This section contains instructions for opening BRF files with Duxbury Braille Translator (DBT) and setting 
default embossing preferences. The DBT software must be installed before performing these steps. 

ViewPlus software can also be used to emboss BRF files (though this may result in formatting errors). If 
you will use ViewPlus software for BRF files, follow the instructions in the section Configuring PRN and 
BRF Files with Tiger Software Suite instead. 

1. In the TA Site, click Help Guide at the top of the page. The online TA User Guide opens. 

a. Sample Braille files can be accessed from the help guide  Appendices  Sample Braille Files. 

2. Click Sample BRF File. The file dialog window opens.  

3. Do one of the following: 

 From the Open with drop-down list, select Duxbury Braille Translator. Click OK. The Duxbury 
Braille Translator program opens and previews the file (see Figure). 

 If the Duxbury Braille Translator is not available as a selectable program, do the following 
(otherwise skip to step 4): 

i. Click Browse. The Choose Helper Application window opens. 

ii. Navigate to the Duxbury folder and open it. 

iii. Open the DBT folder and select dbtw.exe.  

iv. In the Open with window, select Duxbury Braille Translator and mark the Do this 
automatically for files like this from now on checkbox. 

v. Click OK. The Duxbury Braille Translator program opens and previews the file (see Figure 
13). 

 If the Import File window appears, set the Template to either English (American) – 
Standard Literary Format (for Duxbury 11.2 or earlier) or English (BANA Pre-UEB) – 
Literary Format (for Duxbury 11.3 or later), and set the Import Filter to Formatted 
Braille. 
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Figure 10. Duxbury Braille Translator Window 

 

4. In the Duxbury Braille Translator window, go to Global > Embosser Setup. The Global: Embosser 
Setup window appears. To add a new embosser, do the following: 

a. Click New. The Embosser Setup – Untitled Configuration window appears. 

b. From the Embosser Model drop-down list, select the required embosser type. 

c. From the Send to Printer drop-down list, select the required embosser’s name and click OK. 

d. In the Global: Embosser Setup window, click OK. 

5. In the Duxbury Braille Translator window, go to Global > Embosser Setup. The Global: Embosser 
Setup window opens (see Figure 11). 

Figure 11. Global: Embosser Setup Window 

 

6. In the Global: Embosser Setup window, ensure the following are selected: 

 Brailler Device: ViewPlus Max (or whichever supported ViewPlus embosser you are using) 
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 The following Braille Document Formatting options must be set: 

 Emboss in Interpoint checkbox is blank 

 Top margin in lines: 2 

 Binding margin in characters: 5 

 When you are done, click OK. 

7. In the Duxbury Braille Translator window, go to Global > Formatted Braille Importer.  

a. In the Global: Formatted Braille Importer window that appears, mark the Read formatted 
Braille without interpretation checkbox and click OK. 

8. In the Duxbury Braille Translator window, go to File > Emboss. The File: Emboss… window opens. 

9. In the File: Emboss… window, ensure that only one copy is being printed and that the page range is 
set to All. 

10. Click OK. 

Configuring PRN and BRF Files with Tiger Software Suite  
This section contains instructions for opening PRN and BRF files with ViewPlus Tiger Software Suite 
software and setting default embossing preferences. The ViewPlus Tiger Software Suite must be 
installed before performing these steps. 

Although you may use Tiger Viewer as the default application for opening PRN files, if you use it 
alongside an embosser other than the Viewplus Max, Rogue, or Premier, you may need to convert the 
files for your embosser type before printing. Because of this, CAI strongly recommends using Tiger 
Designer as the default application for embossing PRN files.  

Note: In RISE Science Braille assessments, your student may receive clusters that include a grid 
interaction. These may include bar graphs, plotting points, or drawing lines. After you emboss the PRN 
file for the student, you will notice a coordinate grid. Using some type of tactile manipulative, such as 
raised dots, on the grid space to indicate their response to the question. You will then input the 
student’s response based on how the raised dots were placed. 

BRF files can be embossed using Tiger Viewer and Designer;  however, the margins may need to be 
adjusted which cannot be done using Tiger Viewer. In Tiger Designer, the TA will have to modify the 
margins to make sure that the BRF prints correctly (instructions below). If you will use Duxbury Braille 
Translator for BRF files, see the instructions in the section Configuring BRF Files with Duxbury Braille 
Translator instead. 
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1. In the TA Site, click Help Guide at the top of the page. The online TA User Guide opens. 

a. Sample Braille files can be accessed from the help guide  Appendices  Sample Braille Files. 

2. Click Sample PRN File or Sample BRF File. The file dialog window opens. 

3. Do one of the following: 

• To set Tiger Designer as the default application (recommended): 

• From the Open with drop-down list, select Tiger Designer and click OK. The Tiger Designer 
program opens and previews the file (see Figure 12). 

• If Tiger Designer is not available as a selectable program, click Browse and select Tiger 
Designer from the folder where it is installed on your computer. Mark the Do this 
automatically for files like this from now on checkbox and click OK.  

• To set Tiger Viewer as the default application: 

• From the Open with drop-down list, select Tiger Viewer and click OK. The Tiger Viewer 
program opens and previews the file. 

• If Tiger Viewer is not available as a selectable program, click Browse and select Tiger Viewer 
from the folder where it is installed on your computer. Mark the Do this automatically for 
files like this from now on checkbox and click OK. 

Figure 12. Tiger Designer Window   
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1. Go to File > Print. The Print window opens. 

2. Ensure that the printer is set to ViewPlus Max (or whichever supported ViewPlus embosser you are 
using) and that only one copy is being printed. 

3. Click Print.  

• If you experience any issues embossing, refer to the section Converting PRN Files in Tiger 
Designer for Embossing or contact the Help Desk. 

To modify margins in TIDER Designer: 

1. Launch Tiger Designer 

2. Open desired BRF file (File type will need to be changed in the bottom right of the file explorer 
window) (See Figure 13)  

Figure 13. Change BRF file type 
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3. Import Options window will be displayed, this is were margins can be adjusted (See Figure 14). 

Figure 14. Change BRF file type 

 

  



  
 

© Cambium Assessment, Inc.    35 

 

 

Administering Braille Tests 
This section explains how TAs set accommodations  (i.e., test settings) in TIDE for students who will be 
taking Braille tests and how to emboss Braille print requests from students while administering the 
tests. It also provides information about how students navigate the Secure Browser with JAWS.   

TAs must make sure that students have the correct test settings in TIDE before administering tests to 
them. Any test settings that cannot be changed from the TA Site or Secure Browser will need to be set in 
TIDE. Please note that some test settings may vary between Training and Operational tests. For more 
information about test settings, resources and tools, please see the Test Administration Manual. 

A student’s test settings and tools include the available accommodations, such as Assistive Technology, 
along with test tools, such as color schemes. This section explains how to edit student test settings and 
tools via an online form or a file upload. For additional information, please see the TIDE User Guide. 

1. From the Test Settings and Tools task menu on the TIDE dashboard, select View/Edit/Export Test 
Settings and Tools. The View/Edit/Export Test Settings and Tools page appears (see Figure 15). 

Figure 15:  Test Settings and Tools Page 

 

2. Retrieve the student accounts whose settings and tools you want to view or edit by filling out the 
search fields. 

In the list of retrieved students, select  for the student whose test settings and tools you want to 

edit. The View/Edit Students: [Student’s Name] form appears. Click  to expand each section 
(see Figure 16). 

Figure 16:  View/Edit Student Page 

 

3. Modify the student’s record as required. 

https://utahrise.org/resources/user-guides/user-guides/test-administration-manual
https://utahrise.org/resources/user-guides/user-guides/tide-user-guide
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In the available test settings and tools panels, modify the student’s test settings, using Table 10 on 
the following page. The test settings are grouped into categories, such as visual assistance tools, 
presentation, and other accommodations. The panels display a column for each of the student’s 
tests. You can select different settings for each test, if necessary. For students that need Braille 
tests, you will need to set the Language setting to Braille in TIDE (see Figure 17), before testing 
begins. When Braille is set, the Descriptive Audio tool will automatically set to its Braille setting, and 
the Streamline Mode tool will set to On. It is highly recommended that students use the training 
tests with the Secure Browser to verify accommodations are set correctly and to allow the student 
time to practice using the testing tool.  

Figure 17: View/Edit Student Page 
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Table 10: Fields in the Test Settings and Tools Panels 

Field Description 

Streamlined Mode Toggles streamlined mode setting on or off, allowing students to view the items 
from top to bottom and left to right. 

Mouse Pointer* List of available Mouse Pointer sizes and colors. 

Color Choices List of available Color Choice settings. 

Descriptive Audio Toggles Descriptive Audio setting on or off, allowing the answer spaces to be read. 

Braille with Type List of available braille settings (UEB or UEB with Nemeth) where available. 

Print Size List of available zoom levels. This print size setting will also apply to any content 
sent for Print on Request.  

Print on Request List of available Print on Request settings. 

American Sign Language Toggles American Sign Language on or off. 

Assistive Technology Toggles Assistance Technology Mode setting on or off, allowing student to use 
pre-approved hardware or software with secure browser. Requires USBE approval 

Speech-to-Text Allows student to dictate their response in English, only available on constructed-
response items. 

Please note, this tool is not field facing; it requires state-level credentials to see in 
TIDE. 

Word Prediction Enhanced accessibility for low dexterity students to not have to use the keyboard 
as much. 

Please note, this tool is not field facing; it requires state-level credentials to see in 
TIDE. 

Visual Representation Visual Representations are manipulatives such as cubes, tiles, rods, blocks, 
models, etc. They may be used on all sections of the mathematics assessment if 
they are included in the student’s IEP or 504. 

Calculator 6th grade For students in grade 6, the use of a handheld calculation device or printable 
computation table is considered an accommodation and may be provided (based 
on need documented in the IEP) during the allowed segment of the assessment 
only. 

Scribe Students dictate their responses to a qualified person who records verbatim what 
they dictate. Requires USBE approval 

 

*NOTE: If a student needs the mouse pointer accommodation for testing, the changes should be made to the TDS settings in TIDE 
as well as to the settings of the device used for testing.   

 

Changing a test setting in TIDE after the test starts does not update the student’s test setting if the 
same test setting is available in the TA Interface. In this case, you must change the test setting in 
the TA Interface, although the student will need to log out and resume the test for the settings to 
be applied. 
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4. Select Save. 

5. In the dialog box, select Continue to return to the list of student records (see Figure 18).  

Figure 18: Edit Student Continue 

 

Figure 19: Edit Student Continue 

 

Setting Up Braille Test Sessions 
After TAs ensure that students have the correct test settings in TIDE, the next step is to start a test 
session for the student(s) who will be testing. For detailed, general instructions about starting test 
sessions, see the “How TAs Proctor Test Sessions in the Test Administration Site” section in the Test 
Administration Manual. Below are the specific steps to take for Braille administrations.  

1. To administer Braille tests, the TA logs in to the appropriate TA Site and starts a test session. 

2. The TA opens JAWS (or another supported screen reader) on the student testing devices. 

3. The TA opens the secure browser on the student testing devices.  

4. Students sign in to the test session and select their tests. 

5. The TA reviews the student's test settings and verifies the following: 

 Braille is set to ON. This should be set for any students testing with JAWS, regardless of whether 
or not those students are Braille users. Setting the Presentation to Braille will automatically 
enable streamlined mode, which arranges test content vertically. 

https://utahrise.org/resources/user-guides/user-guides/test-administration-manual
https://utahrise.org/resources/user-guides/user-guides/test-administration-manual


  
 

© Cambium Assessment, Inc.    39 

 

 

 Print on Request is set to the appropriate option for the selected test. See the note above about 
the recommended setting for this.  

 Braille Type is set to the student’s preferred Braille option. Students may choose from the 
following options, depending on the test: 

 UEB Contracted with Nemeth Math 

 UEB Contracted with UEB Math 

 Assistive Technology is turned on. This setting must be enabled in order for students to use the 
keyboard commands associated with JAWS. 

6. When all the correct settings are applied, the TA approves students for testing. 

7. Once a student enters their test and is on the first item, the TA can print the braille for a certain 
range of items in the test for ease of administration (i.e., the TA doesn’t have to wait for the student 
to be on an item to print the braille for it; instead, the test will “fetch” a certain range of the next 
items for the TA to print the braille for in advance). The range varies by subject: 

a. For Grade 3 Math, the TA can print 12 items at a time. 

b. For Grades 4 – 8 Math, the TA can print 14 items at a time. 

i. Note that for Grade 6, which has a Segment 1 that does not allow the use of a calculator and 
a Segment 2 that does allow the use of a calculator, a TA’s ability to print braille for a range 
of items will pause at item 41 (in Segment 1) until the student moves to Segment 2.   

c. For Grades 3 – 5 ELA, the TA can print 10 items at a time. 

d. For Grades 6 -- 8 ELA, the TA can print 12 items at a time.  

e. For Grades 4 -- 8 Science, the TA can print 2 clusters at a time.  

Embossing Braille Print Requests 
As students’ progress through their tests, emboss requests will be sent to the TA Site automatically. TAs 
must review and approve these emboss requests in order to send the files to the embossers. Please see 
the “How to Approve a Student’s Print Request for Print-on-Request Accommodation” in the Test 
Administration Manual for more information on this process. For printing Braille, he process for 
embossing print requests is slightly different for BRF and PRN file types. This section provides 
instructions for embossing each file type. 

TAs should be aware of the following notes when embossing print requests for Braille tests: 

https://utahrise.org/resources/user-guides/user-guides/test-administration-manual
https://utahrise.org/resources/user-guides/user-guides/test-administration-manual
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Always plug the embosser into the same USB port used when it was first set up. Otherwise, the 
computer may identify the embosser as a new device and require you to set it up again. 

If a student pauses their test before you print all their queued print requests, the student must 
send manual print requests for any unprinted items that were previously in the queue when 
they resume testing. They will do this using the “Print Passage” or “Print Item” tool in the 
context menu in the Test Delivery System. Please see the “How Students Use Testing 
Resources/Tools” in the Test Administration Manual for more information on this process. 

When the test session is over, you must delete and discard all test materials. This may require 
you to remove files from the web browser download archive. 

For tips and troubleshooting advice for embossing braille files, see Appendix A. 

Sending BRF Files to the Embosser with Duxbury Braille Translator 

1. When you approve a print request that prints in 
BRF format, a print dialog window opens. Select 
Open with from this window. 

a. In the drop-down list, select Duxbury 
Braille Translator. 

b. Click OK. The Import File window opens. 

2. Ensure that the following are selected: 

 Template: 

 For Duxbury 11.2 or earlier: English 
(American) – Standard Literary Format 

 For Duxbury 11.3 or later: English 
(BANA Pre-UEB) – Literary Format  

 Import Filter: Formatted braille 

Figure 20. Import File Window 

 

3. Click OK. The Duxbury Braille Translator preview window opens. 

4. Go to File > Emboss. The File: Emboss window opens. 

5. Ensure that only one copy is being printed, the page range is set to All, and the Brailler Device is set 
to ViewPlus Max (or other ViewPlus embosser). Then click OK. 

Sending BRF Files to the Embosser with Tiger Software Suite 
Embossing BRF files with Tiger Software Suite may result in formatting errors. It is recommended that 
you use Duxbury Braille Translator for BRF files instead. However, if Tiger Software Suite is the only 
embossing software available, you may follow the instructions below to emboss BRF files. 

https://utahrise.org/resources/user-guides/user-guides/test-administration-manual
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1. When you approve a print request that prints in BRF format, a print dialog window opens. Select to 
Save the file to your computer. 

2. Do one of the following: 

 Using Tiger Viewer: Right-click the downloaded BRF file, select Open With and choose Tiger 
Viewer.  

 Using Tiger Designer: Launch Tiger Designer and select File > Open. Select the downloaded BRF 
file (you may need to set the file type to BRF in the bottom-right dropdown). Ensure the Paper 
Size is set to 11.5 x 11 and increase the left margin to .5 inches. Click OK. 

3. Select File > Print. Ensure that only one copy is being printed and the Printer Name is set to 
ViewPlus Max (or whichever supported ViewPlus embosser you are using), then click Print. 

Sending PRN Files to the Embosser and Converting them for Printing 
1. When you approve a print request that prints in PRN format, a print dialog window opens. Select to 

Save the file to your computer. 

2. Locate the saved PRN file and open it: 

a. If Tiger Designer is set as the default program for PRN files, a Print window appears. Ensure that 
only one copy is being printed and the Printer Name is set to ViewPlus Max (or whichever 
supported ViewPlus embosser you are using), then click Print. 

Figure 21. Tiger Designer Print Window 
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b. If the option to print is grayed out, you will 
need to convert the file by following the 
steps below: 

i. If a popup message appears indicating 
that the file needs to be converted, 
click Yes in this message. If this popup 
message does not appear, then go to 
File>Save As to convert the file 
manually. 

 

Figure 22. Grayed-Out Print Button 

 

Figure 23. Convert File Message 

 

ii. Save the file as a Tiger Designer 
Documents file type (.TDSX) and click 
Save. You should now be able to print 
the print request file by clicking Print. 

Figure 24. Saving as a TDSX File 

 

Removing Files from the Web Browser Download Archive 
Most supported web browsers automatically save downloaded files. If your computer saves the BRF and 
PRN files from print requests, you must delete all test-related files from your browser’s download 
archive, for security purposes. 

To remove files in Google Chrome: 

1. Open the Chrome menu  icon in the upper-right corner. 

2. Select Downloads. The Downloads page opens. 

3. Remove all test-related files by doing one of the following: 
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 For each file, click X. 

 Click Clear all in the upper-right corner. Files saved to your computer are not deleted. 

To remove files in Edge: 

1. Open the Edge Hub (Favorites, reading list, bookmarks and downloads)   icon in the upper-right 
corner. 

2. Select Downloads from within the downloads list.  

3. Select each file and click X to delete it. 

To remove files in Mozilla Firefox: 

1. Open the Tools menu and select Downloads. The Library window opens. 

2. Delete all test-related files by doing one of the following: 

 Select each file and press Delete on your keyboard. 

 Click Clear Downloads at the top of the window (if available). Files saved to your computer are 
not deleted. 

Tips for Embossing Braille Files 
This section provides tips for approving print requests and embossing braille files. 

The auto-emboss setting in TDS automatically queues multiple print requests in advance 
as students progress through a test. If a student testing with auto-emboss pauses their 
test before you print all their queued requests, then when the student resumes testing, 
they must send manual print requests for any unprinted items that were previously in 
the queue. 

When approving print requests, you can either save a file to your computer and 
manually open it in the embossing software, or you can open it directly from the 
browser. The steps for saving and opening braille files depend on which browser you are 
using: 

• For Google Chrome users: The browser displays the downloaded file at the bottom of the screen 
(see Figure 25).  
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Figure 25. Downloading Braille Files in Chrome 

 

• To open the file directly from the browser, double-click the downloaded file. 

• To save the file to your computer, click the up arrow icon beside the downloaded file and 
select Open. 

• For Firefox users: The browser opens a dialog window (see Figure 26).  

Figure 26. Downloading Braille Files in Firefox 

  

• To open the file directly from the browser, mark the Open with radio button and make sure 
the appropriate embossing software is selected in the menu (Duxbury Braille Translator for 
BRF files; Tiger Designer or Tiger Viewer for PRN files). Then click OK.  

• To save the file to your computer, mark the Save File radio button and click OK. 

• For Edge users (version 44 and earlier): The browser displays the downloaded file in a dialog box 
at the bottom of the screen (see Figure 27).  

• To open the file directly from the browser, click Open.  

• To save the file to your computer, click Save. 
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Figure 27. Downloading Braille Files in Edge 44 

 

• For Edge users (Chromium version 79 and later): The browser shows the downloaded file in the 
bottom left corner of the screen (see Figure 28). 

Figure 28. Downloading Braille files on Chromium-Based Edge 

 

• To open the file directly from the browser, click the blue Open File link. 

• To save the file to your computer, click the three-dot menu icon and select Show in folder. 
This will open File Explorer to the location where the file is saved in your downloads folder. 

If you cannot find a downloaded braille file after approving a print request, you may 
need to modify your browser’s download settings (please contact your local IT support 
for assistance editing these settings). 

It is highly recommended that you rename downloaded files to correspond with the 
item number listed on the TA Site’s Print Request window, so you can keep track of 
printouts when downloading multiple files at once. For example, Item 10 shown in 
Figure 30 would download with the name brf_enu_tds_bt_ecn, but you can simply add 
item10 to the beginning of the file name so that it becomes 
item10_brf_enu_tds_bt_ecn. 
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Figure 29. TA Print Request Window 

 

Always plug the embosser into the same USB port used when it was first set up. 
Otherwise, the computer may identify the embosser as a new device and require you to 
set it up again. 

If the Print button for a PRN file is grayed out in Tiger Designer or Tiger Viewer, you may 
need to convert the file in Tiger Designer before embossing it. 

 

Navigating the Student Testing Site with JAWS 
JAWS allows students to use keyboard commands to navigate through the Student Testing Site. Students 
using RBDs with router keys may also press the router key above the text for a button to move the 
cursor to that button. They can press the router key again to select that button instead of using the 
provided keyboard commands. 

The actions associated with each JAWS keyboard command depend on the context in which the 
students presses the key. In other words, the same key may have different effects depending on 
whether the student is on the Sign-In pages, the test pages, or within the items and stimuli of the test 
pages. 

Note: The Tab key is best used to move among elements such as buttons, text boxes, etc. 

Table 11 on the next page provides an overview of how to use JAWS keyboard commands in each 
context. In order for students to use these keyboard commands, Assistive Technology must be enabled 
for them in TDS. Use Forms Mode to navigate within an element, such as a listbox which allows multi-
selection of options in the list. Forms Mode should either be activated automatically when focus is 
brought to that element using Tab or by pressing Enter on the element. The arrow keys should then be 
used. To exit Forms Mode, press Esc or NUM PAD PLUS and use the arrow keys. This allows a page to be 
read in detail, including plain text such as test questions. 
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Table 11. Overview of JAWS Keyboard Commands in the Student Testing Site 

Key Action 

Navigating the Sign-In Pages with JAWS Keyboard Commands  

Insert + F10 
(standard 
keyboard) 

Space + S (Perkins 
Braille keyboard) 

Returns the focus to the Secure Browser if the student navigates to the JAWS application 
window while signing in.  

Keyboard layouts may vary by device. Please refer to the manual provided by the device 
manufacturer for more information. 

Tab Moves the focus to the next field or button on the page 

Shift + Tab Moves the focus to the previous field or button on the page 

Down Arrow Reads the next line on the page 

Up Arrow Reads the previous line on the page 

Enter Selects the button that is currently in focus 
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Table 11. Overview of JAWS Keyboard Commands in the Student Testing Site (Contd.) 

Key Action 

Navigating Test Pages with JAWS Keyboard Commands 

R Navigates to the next landmark region on the test page. A test page has up to three primary landmark regions:  

• Banner Region: The banner contains the test information row. This row displays the current question numbers, 
test name, student name, test settings button, pause button, and help button. 

• Navigation and Test Tools Region: This region displays the navigation and tool buttons. 

• Test Content Region: This region consists of the Stimulus section and the Question section: 

o Stimulus Section: Contains the stimulus title, stimulus context menu, and stimulus content. 

o Question Section: Contains a question number, question labels (labels that appear when you mark an item 
for review, print an item, or enter a note for an item), question context menu, question prompt, and the 
response area. 

H Jumps to the next heading on the page.  

In general, the following test components are defined with a heading: 

• Test name (H1) 

• Student name (H2) 

• Passage title (H3) 

• Question number (H3)  

On test pages that have multiple questions, students can jump directly from one question to the next. To do so, 
press H and then press the Down arrow twice. The question stem is read aloud. 

Shift + R Jumps to the previous region on the page. 

Shift + H Jumps to the previous heading on the page. 

Tab Moves to the next component on the page. In general, the following test elements are components: 

• Navigation and tool buttons  

• Question number (and associated prompt text) 

• Context menu 

• Response options 

Shift + Tab Moves to the previous component on the page 

Enter Selects a button or response option or open a context menu. 

Down Arrow Moves to the next line on the page 

Up Arrow Moves to the previous line on the page 

Insert + Down 
Arrow 

Reads everything on the page (from the current point of focus) 

Ctrl or Space Stops JAWS from reading 
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Table 11. Overview of JAWS Keyboard Commands in the Student Testing Site (Contd.) 

Key Action 

Opening and Using Context Menus with JAWS Keyboard Commands 

Enter Pressing Enter when JAWS reads “Menu button” will open the context menu. This is the only way to open the context 
menu when streamlined mode is turned on. 

Down Arrow Moves the focus to the next option in the menu. JAWS will read this option aloud. 

Up Arrow Moves the focus to the previous option in the menu. JAWS will read this option aloud. 

Space Selects the menu option currently in focus 

Esc Closes the context menu without selecting any options 

Responding to Items with JAWS Keyboard Commands 

Tab • Students can use the Tab key to navigate to the item prompt, which JAWS will read aloud. 

• After JAWS reads the prompt aloud, students can press Tab again to navigate to the response area. They may need 
to press Tab multiple times depending on the item type and whether any question labels appear for the item. 

• In the response area for an item, students can press Tab to navigate between each answer option, text box, 
selectable text field, keypad button, or check box, depending on the item type. 

Shift + Tab Navigates to the previous answer option, text box, selectable text field, keypad button, or check box, depending on the 
item type. 

Up and Down 
Arrow Keys 

• For multiple choice and multi-select items, pressing the arrow keys will move between each answer option. 

• For edit task choice items, pressing the arrow keys will move between each line of text in the item. After users 
open an edit menu by pressing Space, the arrow keys can be used to move between the answer options in the 
drop-down list. 

Space • For multiple choice and multi-select items, pressing Space will select the answer option in focus. 

• For edit task items, pressing Space will open the edit menu in which students type or select a response. 

• For table match items, pressing Space will mark the checkbox in focus. 

Enter • For hot text items, pressing Enter will choose the selectable text area in focus as the answer option. 

• For edit task choice items, pressing Enter will select an answer option from the drop-down list in the edit menu. 

• For equation items, pressing Enter will select the keypad button in focus. 

Alt + 7 • For equation items, pressing Alt + 7 will open a popup menu with special characters. Students can use the arrow 
keys to move between the special characters in the list and then press Enter to insert a special character in the 
response area. 

Please note that the keypad of the Desmos calculator tool in the Student Testing Site is not able to be 
tabbed. However, all buttons within the keypad can be navigated or selected using JAWS or Desmos 
keyboard commands. For a list of Desmos keyboard commands, see 
https://www.desmos.com/graphingshortcuts.  

  

https://www.desmos.com/graphingshortcuts
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User Support 
For information and assistance in using the Online Testing System, contact the RISE Helpdesk. The 
Helpdesk is open Monday–Friday 7:00 a.m. to 4:00 p.m. Mountain Standard Time (except holidays or as 
otherwise indicated on the RISE Portal). 

 

Please provide the Helpdesk with a detailed description of your problem, as well as the following: 

The brand and version number of the assistive technology being used 

Any error messages and codes that appeared, if applicable 

Operating system and browser information, including version numbers (for example, 
Windows 11 and Firefox 72 or Mac OS 12.6 and Safari 11) 

RISE Assessment Program Helpdesk 

Toll-Free Phone Support: 877-269-4966 

Email Support: RISEhelpdesk@cambiumassessment.com 

 

mailto:RISEhelpdesk@cambiumassessment.com
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